LIGHTWRIGHT 4 UPGRADE NOTES
Welcome! I’m sure you’ll appreciate all of the new features in this new release, but so
much has changed that you will definitely need this guide to help you get the most out
of Lightwright 4. I also recommend reading the Work Notes and Focus Charts sections
of the Reference manual.
Bon Appetit!

January 11, 2005

WHAT’S NEW
(And Where to Read About It)
System Requirements & Installation............................................................ page 2
Overall Capacity / New Number Options, New Columns ...................................3
Show Files & Folders: A new way to organize ..................................................4
Menu Changes, a.k.a. Scrambled Eggs.................................................................5
Adding Lights ........................................................................................................5
Worksheet ..............................................................................................................6
Toolbar, including “Go Back” ..............................................................6
Bookmarks.............................................................................................7
Deleting..................................................................................................7
Dragging ................................................................................................7
Cell Editing............................................................................................7
View Menu, including Focus Status ...................................................10
Highlighting Changes..........................................................................10
Protecting Cells, also Non-Editable Cells ..........................................10
Collapsible Worksheet Rows ..............................................................11
Contextual Menus................................................................................11
Maintenance: Weight, Symbol, Focusable, Collapsible, etc..............................12
Attribute Lists (they’re not just for moving lights) ............................................13
Accessories...........................................................................................................14
Focus Charts.........................................................................................................15
Work Notes .........................................................................................................17
Sharing: Work notes, Changes, Focus Charts, CAD Import & Export .............19
Layout Features: First Page/Next Page, New Options, Focus Objects..............20
Printing: Attributes, Work notes, Watermarks ...................................................23
Counting...............................................................................................................24
Dimmers & Control .............................................................................................24
Template Sizes .....................................................................................................24
Reports & Error Checks ......................................................................................25
Preferences ..........................................................................................................25
Miscellany, including Help and Student Licensing............................................28
Keyboard Shortcuts .............................................................................................30

Page 1 of 30

SYSTEM REQUIREMENTS
Microsoft Windows
Microsoft Windows 98/NT/2000/ME/XP or later.
A CD-ROM drive (for installation only).
256MB of physical RAM, 512 recommended, 1GB for very large shows.
A color monitor with at least 800x600 resolution, 256 colors or better.
Mouse
A hard drive with at least 35 MB of available disk space

Macintosh
Mac OSX 10.2 (Jaguar) or later.
A CD-ROM drive (for installation only).
256MB of physical RAM, 512MB recommended, 1GB for very large shows.
A color monitor with at least 800x600 resolution, either thousands or millions of colors.
Mouse.
A hard drive with at least 20MB of available disk space

INSTALLATION
Lightwright 3 does not need to be installed on your computer in order to install Lightwright 4. Version 4
belongs in its own folder, separate from the version 3 folder. Version 4 has a new set of serial numbers and
approval codes. If you do not have your approval code yet, visit www.mckernon.com to register.

Microsoft Windows
Find setup.exe in the Lightwright folder on the Lightwright 4 CD and follow the instructions. Once you
install Lightwright, DO NOT move or rename the Lightwright 4 folder or the lw4.exe file contained in
it. We also recommend rebooting after installing Lightwright 4 in Windows.
Check www.mckernon.com to see if there is a more up to date version of Lightwright available. If so,
download and install that version before continuing.
After you install Lightwright, the first time it runs it will ask you for your serial number, registered
name, and approval code.

Macintosh
Drag the Lightwright 4 folder from the CD into the Applications folder on your Mac’s startup hard
drive.
Check www.mckernon.com to see if there is a more up to date version of Lightwright available. If so,
download and install that version before continuing.
After you install Lightwright, the first time it runs it will ask you for your serial number, registered
name, and approval code.
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OVERALL CAPACITY & NUMBERING RULES
Overall capacity is now up to 30,000 worksheet rows, with up to 6,000 unique entries in each of the “text”
categories such as Position, Purpose, and Color. If you think you’ll never need that many, imagine a show with
1500 moving lights…
Channel, Dimmer, and Circuit numbers up to 32,000 (in up to 62 DMX universes) with or without any one of
these options:
Single letter prefix A-Z
Single letter suffix A-Z
Decimal number suffix 0-250

Examples: N400, H12, Z52
Examples: 400N, 3C, 32000Z
Examples: 1.0, 1.1, 1.2, 32000.250

Letter prefixes should generally be used for things like Non-Dims or Hot Pockets
Decimal number suffixes are normally used for moving light attributes
You cannot combine prefixes and suffixes.
Examples of illegal numbers:
N400C
B3.2
4A.12
Unit numbers 0-16,000 with or without any one of these options:
One or two letter prefixes
Letter suffix a-z:
Decimal suffix 0-250

Examples: A4, ZG3, ML6
Examples: 14a, 16000z
Examples: 14.1, 14.2, 14.250

Letter prefixes are normally used for striplights.
Letter suffixes indicate lights inserted between other lights
Decimal suffixes can be used for moving light attributes and intelligent devices/accessories
Examples:

No. 1 Elec #14.0
No. 1 Elec #14.1
No. 1 Elec #14.2
No. 1 Elec #14.3

Cyberlight
Cyberlight
Cyberlight
Cyberlight

No. 2 Elec #3.0 PAR 64 MFL
No. 2 Elec #3.1 ColoRam II

Moving Light 3
Pan
Tilt
Pattern
Downlight
Scroller

You can now have up to 40 layouts, 20 automated actions, and 40 watermarks,. There is an overall maximum of
30,000 graphic images per show.

New Data Columns
There are now a total of six user-definable text columns and six user-definable number columns.
Any of the user-definable number columns can be formatted as:
Channel
Dimmer
Wattage
##### (+-0-32000)
#####.# (+-0-32000.9)
#####.## (+-0-32000.99)
IP Address (###.###.###.###)
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SHOW FILES & FOLDERS
Version 4 show files are kept each in its own separate folder unless a group of show files all relate to the same
production and share the same focus charts. Within that folder, Lightwright automatically creates “Focus
Graphics” and “Layouts” folders containing show-specific layouts and copies of any of the graphics used by the
show’s focus charts. You can put multiple versions of the show file in the same folder, which will permit them
to use this common pool of graphics and layouts. However, you should NOT put show files from different
venues or productions into the same folder. These folders are not optional and will automatically be recreated if
you delete them.
The show’s Focus Graphics folder contains only graphics used by the show’s focus charts.
The show’s Layouts folder contains show-specific layouts and any graphics used in the page header or on the
Focus Charts Cover Page.
When you choose Save As… from Lightwright’s File menu, you have a choice of making a new folder for the
show file or just saving it under a new name. If you choose “In New Folder”, Lightwright will create a folder
with the same name as the show file, but with a suffix (of your choice) added to it. Use Edit / Preferences /
General to set the suffix Lightwright will use. If the show file is untitled, the default is to create a new folder.
The “Open Layout - For this show” menu item opens the show’s layouts folder for you to retrieve a layout from
it.
The “Open Layout - For any show” menu item opens the Lightwright application’s layouts folder for you to
retrieve a layout from it.
Pop-up Layout menus will present a list of layouts that are in either the current show’s folder or the Lightwright
applications folder. Layouts above the dividing line in the menu are in the show’s folder, ones below the line
are in Lightwright’s folder.

Old Show Files
Version 4 can read both version 2 and version 3 show files. It can also save version 4 show files in both
versions 2 and 3 format, but those formats will not include columns or number formats new in version 4 (such
as decimal unit numbers, template holder sizes, work notes, and focus charts). Decimal portions of channel,
dimmer, and circuit numbers will be chopped off (for instance, channel 32.6 will become simply 32). And of
course, older versions know nothing about things like template holder sizes or symbol names, so any of the
other new features will be lost when exported back to earlier versions.
To save in version 2 or 3 format, use File/Export. Version 4 show files can be freely shared between Windows
and Macintosh, there is no need for any kind of conversion.
Note that when you export to version 3, any hanging positions containing attribute rows will have their order
“locked” so that the attributes stay in the correct sequence. If you bring one of these show files back into
Lightwright 4, use the Worksheet/Attach to Attributes List command to make them behave like proper attribute
rows.
Version 4 can read version 3 layouts, libraries, and phase template files, and will convert them to version 4
format when necessary. Like show files, all of these kinds of files can be used and freely shared between the
Windows and Macintosh operating systems (in previous versions, layouts were not compatible). If you want to
use your existing version 3 layouts, copy them into version 4’s Layouts folder. However, be prepared to do
some work on them, as many options have changed.
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MENU CHANGES
The arrangement of menus has changed quite a bit, in every case to make commonly-used commands more
readily accessible. Although strange at first, you will soon come to enjoy the new arrangement.
Setup/Lightwright Prefs has moved. In Microsoft Window it is at the bottom of the Edit Menu. In
OSX, it is under the Lightwright menu.
Show Prefs are now “up front” in the Setup Menu instead of being in a sub-menu.
List Maintenance now has its own “Maintenance” menu.
Setup/System is now Setup/System Breakdown
Setup/Dimmers is now Setup/Dimming System
Setup/Lightwright Prefs/General – Use UniverseFormat is now simply Setup/Use Universe Format
A new Attributes menu has been added for Layout, and new contextual menu options have been added.

ADDING LIGHTS
In Lightwright 3, clicking in any open area of the worksheet would bring up the Adding Units form. This same
behavior is available in version 4, but only if it has been turned on using Preferences/Worksheet. Which of
course, means you can now turn the behavior off if it has always annoyed you!
You can now use the Adding Units window to add multiple worksheet rows in any category, not just unit
numbers. For text categories, separate the items with backslashes (“\”). For numeric categories, use commas
and/or hyphens. However, you can only do this in one category at a time. So if you want to enter dimmers 1-12,
you can’t enter colors L-201\R-33\L-161 at the same time. This also means you cannot add multiple unit
numbers in multiple positions at the same time.
You can also end any of the number columns (such as channel, dimmer, and circuit#) with “+” to have
Lightwright automatically raise the number for each light it adds, and a “Match channel decimals to attributes”
option for instrument types that have attribute lists will put a matching decimal on each channel number.
In LW2 and LW3, you entered multiple striplights by entering the beginning letter, the ending letter, and the
circuit number, such as “AD1”. In LW4, you need to enter “A1-D1” instead because AD1 is now a legal
striplight unit number.
Please be aware that if you choose to number moving lights using letters traditionally used for striplights (such
as “M1”), Lightwright will count the lights as striplights unless you give the instrument type a device type of
Moving Light (see List Maintenance).
After you click either the “Add” or “Add & View” button, the lights that were added will be added to a list at
the bottom of the Adding Units window, so you can see what you did. This list includes as many as 200 lights,
and is cleared each time you close the Adding Units window or switch focus away from it.
If you make a mistake, click the Undo Add button in the Adding Units window to remove the lights you added
before you return to the worksheet.
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WORKSHEET
Most of the worksheet behaves the same way it did in version 3, but it has a whole new look and a lot of new
features:

For starters, notice the shading (in the color of your choice) that intelligently groups worksheet rows together
whenever a light consists of more than one row. To set the shading color, visit Preferences/Worksheet. And yes,
this screen shot is from the Mac OSX version. The Windows uses Microsoft’s standards for appearance.
Across the top of the worksheet is an expanded toolbar, and below that are the new Bookmark buttons.
The red triangle at the left end of the header expands and collapses worksheet rows that parts of lights
connected to attribute lists.
The red circles are focus status indicators, and the funny little icon on the far right side of Rail #4 means there is
a work note attached to that light.
Also notice the new Focus tab, which is where you work on focus charts.
More on all of these features later. The Getting Started manual includes tutorials on attributes, focus charts, and
work notes, and the Reference manual has details on all of them.
Lightwright 4 supports mouse wheels, too. Windows users will neeed to turn on support for them using
Edit/Preferences/Worksheet. The mouse wheel is always enabled on Macintoshes.

Toolbar
There are now five View and five Sort buttons instead of the previous three of each. To set what each button
does, choose the View or Sort you want from the View & Sort pop-ups, then Control-Click (Apple+Click in
Macintosh) the button you want to have that View or Sort.
As a result, the former Setup/Toolbar option has been removed.
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At the far right end of the toolbar there is now a “Go Back” button, which can step back through what you have
been looking at on the worksheet and focus charts. There is a limit of ten back-steps. Pressing Escape <Esc> is
a shortcut for clicking this button.

Bookmarks
Bookmarks take you back to a specific place in either the worksheet or focus charts with a single mouse click.
They restore the View, Sort, scroll position, and Limits. To jump to a bookmarked location, either click the
button or press the corresponding function key (F1-F4).
To set a bookmark, either click the “S” button to the left of the bookmark button, or hold down the Ctrl key
while pressing the appropriate function key. (Use the Apple key in Macintosh)
Bookmarks can be particularly useful during focus sessions. When you need to switch between electrics, click
the appropriate bookmark or press the appropriate function key.

Deleting Units
Lightwright 4 understands lights consisting of multiple worksheet rows better than previous versions, so
striplights and moving lights that consist of many worksheet rows can be handled as a single object.
When you choose to delete a worksheet row, you can choose between deleting just the one selected row, or you
can have Lightwright also delete all of the other related rows that make up that light, including things like
attached color scrollers.
Examples:

If you delete one row of a striplight, it will delete all of the rows that make up that striplight.
If you delete one row of a moving light (or any kind of light with attributes attached to it),
Lightwright will delete all of the worksheet rows that are part of that moving light.
If you have a regular light with a color scroller attached and you delete the light, the scroller will
not be deleted unless you select it also or choose to delete “ALL”.
If you have ten worksheet rows, all with the same position but no unit numbers and you choose to
delete one of them, only that one will be deleted because lights without unit numbers are always
considered as separate lights.

Dragging
The new default when dragging worksheet rows up or down is for Lightwright to always drag all of the rows
that make up a single light as a group, even if only one of the rows is selected. If you want to drag just one row,
hold down Ctrl (Windows) or Apple (Macintosh) while dragging. This is the reverse of the way it worked in
LW3. Note that rows linked to attribute lists will always drag together and their order cannot be altered from the
order in the attribute list.
If you are viewing All, sorted by Position, and you drag a worksheet row up or down, then the worksheet sort
order for the affected position will be locked. (In LW3 this worked only if you were viewing a single position.)

Cell Editing & Viewing
In addition to Ctrl/Cmd-clicking and Shift-clicking, you can now drag across worksheet cells to select them.
Option/Ctrl+Shift Clicking: If you drag while holding down Option/Ctrl+Shift, all of the cells you drag over
will have the contents of the edit field pasted into them as you drag over them. Cells outside the starting column
will not be changed, even if you drag horizontally into them.
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You can now do a Partial edit (using “=” in the edit field) on all kinds of columns, not just text columns.
When editing worksheet cells, you can now add a plus sign (+) to the end of any number:
This tells Lightwright to raise that number once for each selected cell, thereby renumbering the cells,
which can be very useful when doing things like assigning DMX values to moving light attributes.
Example: Your worksheet looks like this:
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC

#1
#2
#3
#4
#5

S4-36
S4-36
S4-19
S4-19
S4-26

Ends L Near
Ends L Far
Downlight
Special
US Area (105)

(101)
(69)
(23)
(155)

If you select the three cells containing 69,23, and 155 and enter 4+ into the worksheet’s edit
field, you will get these results:
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC

#1
#2
#3
#4
#5

S4-36
S4-36
S4-19
S4-19
S4-26

Ends L Near
Ends L Far
Downlight
Special
US Area (105)

(101)
(4)
(5)
(6)

If the worksheet is sorted By Position and you select one cell that is part of an attribute list, then
each of the corresponding cells for every subsequent attribute of that light will automatically be
given a new number, even though you only selected the one cell.
Example: You are viewing the No. 1 ELEC in order by Position. One of the lights is a moving
light, made up of these rows –
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC

#1.0
#1.1
#1.2
#1.3
#1.4
#1.5

VL 2000Fixture 3
VL 2000Pan
VL 2000Tilt
VL 2000Gobo
VL 2000Color
VL 2000Speed

(101)
(102)
(103)
(104)
(105)
(106)

If you select just the one cell containing (102) and enter 1+ into the worksheet’s edit field,
you will get this:
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC
No. 1 ELEC

#1.0
#1.1
#1.2
#1.3
#1.4
#1.5

VL 2000Fixture 3
VL 2000Pan
VL 2000Tilt
VL 2000Gobo
VL 2000Color
VL 2000Speed

(101)
(1)
(2)
(3)
(4)
(5)

“All” is now the first item on the worksheet’s View menu, instead of being last.
If you paste into a group of worksheet cells and there is not enough data on the clipboard to fill the cells,
Lightwright 4 will repeat the existing data on the clipboard until all of the selected cells have been filled.
The Raise# and Lower# commands now raise selected cells relative to the cell contents, not on the contents of
the worksheet’s edit field. Example: The Raise# command will raise 5-10 to become 6-11.
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Microsoft Windows only: The “Insert” key now puts information down in cells the same way it did in version 2
of Lightwright. Use Enter to pick info up, use Insert to put it back down in a cell.
To view work notes attached to particular lights, select the “Show Work Notes” checkbox. Selecting this option
causes any work notes attached to specific lights to appear on the worksheet directly under the relevant light. (If
the total number of lights plus the total number of work notes exceeds 32700, then some work notes will not be
displayed.)
When you choose this option, Lightwright will ask which notes you want to see on the worksheet, based upon
their status.
If you click on a work note on the worksheet, the work note editing form will open, allowing you to modify or
delete the note.
In addition to the new user-definable columns, there are some other new columns:
Focus Status

Click on this column to change the focus status of a light.
See “Focus Charts” for details

Work Note Status

This column shows you whether or not there are any work notes that apply
to each worksheet row. If there is a work note that applies to the row, a
small icon will appear in this column showing the status of the note:
To Do
Pending
Discuss
(Work notes marked as “Done” do not show up here.)
If you move the mouse pointer over the status column, a description of the
work note will appear under the Worksheet’s edit field.
Click on a work note icon to bring the Work Note window forward. The
note referred to by the icon will be at the top of the work notes window and
selected.
If you click in the work note status area when an icon is not showing, the
“Add A New Work Note” form will open, defaulting to attaching the note
to that light.

Dimmer Phase

Shows the power phase for each worksheet row.
This column cannot be edited, as what it shows depends upon the contents
of the dimmer column and the phase letter entered in Setup/Dimming
System/Dimmer Details
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VIEW MENU
The worksheet’s View menu has added options for the new data columns available, as well as some special
ones relevant to work notes and focus charts:
Focused
Lights that have been focused (small green dot)
Partly Focused
Lights that have some data written in their charts, but that haven’t been marked as focused (yellow
diamond)
Not Focused
Lights that have nothing written in their charts (red circle with an “F” in the center)
To Be Focused
Lights that are either not focused or only partly focused
Has Work Note
Any lights that have a work note attached to them. Note that the work notes themselves won’t appear
unless you also check the “Show Work Notes” checkbox.
Changes
Worksheet rows where one or more cells have changed (refer to “Highlighting Changes”, below)

Highlighting Changed Cells
Whenever you make a change in any cell or add or remove lights, Lightwright sets a special internal “flag” for
that cell and row. When you choose the Worksheet/Reset Cell Highlighting command, Lightwright clears the
flags.
The “Highlight Changed Cells” option tells Lightwright to use red to draw the cells that have changed since the
last Reset. The cells will stay red until you either Reset the highlighting, or turn off the highlighting by unchecking the Highlight Changed Cells option. You can turn the highlighting back on at any time, but the
Worksheet/Reset Cell Highlighting command permanently clears the internal change flags.
Printouts can also show this highlighting, which will be red if you are printing in color or outlined if not.
You can use the View menu to view just lights that have had changes made anywhere in them. Use
View/Changes. If you don’t see any red cells, it’s possible that the cells that were changed are in a column that
you have turned off.

Protecting Cells
New worksheet menu options:
Lock All Cells
Lock Selected Cells
Unlock All Cells
Unlock Selected Cells
Any number of worksheet cells can be protected so that changes can’t be made in them until they’ve been
unlocked. This can be very helpful on occasion: For example, you have moving lights number ML1 through
ML6 interspersed with other lights on a pipe. If you lock the cells containing the unit numbers for the moving
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lights, then you can select the entire unit number column and renumber it without changing the moving light
unit numbers.
To protect cells, select them and then choose Worksheet/Lock Selected Cells. You can also unlock cells with
this menu as well as lock and unlock all of the worksheet rows in the show.
When cells are locked, a small red dot appears in the lower right corner of the cell.
Non-Editable Cells
Worksheet cells that cannot be edited will show a small black dot in the lower right-hand corner of the cell. (A
red dot means the cell has been locked manually, see above). The following restrictions may apply to black dot
cells:
Wattages
If the instrument type has the “Lock” option clicked, the wattage will always match
the default wattage shown in list maintenance.
Purposes
If the instrument type has attributes and the worksheet row is an attribute, then the
purpose cannot be changed in the worksheet, only in the attributes list (Setup / List Maintenance /
Instrument Type, click the Attrib column).
Unit Numbers
If the instrument type has attributes and the worksheet row is an attribute, then the
unit number’s decimal suffix cannot be changed.

Collapsible Rows
Lights with decimal unit numbers or which use attributes can be collapsed down into one visible worksheet row,
for instance to hide moving light attributes you may not want to see.
In order for a row to be hidden when viewing sorted by Position, either the instrument type must have the
“Hide” column checked in List Maintenance, or the instrument type must have the “Hide” option checked for
one or more of its attributes.
The possibility of collapsing a light is indicated by the presence of a “Disclosure Triangle” to the left of the
appropriate worksheet row. If the triangle is red and pointing to the right, then there are one or more rows
hidden. Clicking on the triangle will expose the rows, and the triangle will then be dark gray and pointing down.
Clicking again on the triangle will hide the rows again.
To hide or reveal all possible rows on the worksheet, click on the triangle in the column header. Paperwork
printouts also have options to show or hide rows.
Contextual Menus
More options are available via contextual menus (Windows: Right-click, Macintosh: Ctrl+click or right-click),
including Cut/Copy/Paste/Clear and Toggle Universe Format
Toggling Universe Forrmat on and off is accessible through a contextual menu as well as the new Setup/Use
Universe Format option. Note that dimmer numbers beginning with letters are not part of the usual dimmer
ranges, so they cannot switch to universe format. In addition, a new option in Setup/DMX Universes permits
you to force a system to always display in universe format.
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MAINTENANCE
Besides getting a major menu of its own, there are a lot of new goodies here:

Variable-Speed Dragging
Dragging items up and down past the top and bottom of the Maintenance List, Counting List, and the
Worksheet is easy to control now, with a new variable-speed drag. The further past the top or bottom of the
window you move the cursor, the faster the drag will be.

Always Capitalized
You can now keep any category capitalized, and Preferences/Worksheet has a new option to “Ignore Text
Case”.

New Instrument Type Options
Weight

The weight of the instrument, in either kg or pounds

Note

Any kind of short text, up to 60 characters long.

CAD Symbol

The symbol used by your CAD program when it draws the instrument. This field is
usually filled by importing data from a CAD program, and it can be up to 60 characters
long.

Other

This field has no defined use at this time, but can be used for Spotlight’s Legends or other
needed instrument type dependent data such as manufacturer or catalog number.

On Light Plot

Instrument types with this mark means the lights are on your CAD program’s light plot.
There are import and export options that can look at this mark and thereby determine
which lights should be exported.

Lock Watts

Selecting this option enforces the default wattage for every instance of the light. This
prohibits changing the wattage on the worksheet.

Focusable

Focus charts (and focus status) will only be available for instrument types with this
option checked.

Collapsible

If this option is selected, rows with this kind of light will be hidden when worksheet rows
are collapsed. Lights with attribute lists do not use this column to set the visibility,
instead the “collapsibility” of each attribute is set on the attributes list.

Attrib

Moving lights and other multi-channel fixtures can have multiple attributes, indicated by
decimal unit number suffixes. For instance, a moving light with separate channels for
Pan, Tilt, Intensity, and Color would need four attributes, indicated by unit numbers
ending in .1, .2, .3, and .4 (such as 100.1, 100.2, 100.3, and 100.4).
Clicking on this column in Maintenance opens the Attributes List window, where you can
edit the attributes.
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ATTRIBUTE LISTS
Attribute Lists are new to Lightwright 4, and can help ease the horrors of moving lights and other devices that
require dozens of channels and DMX numbers. They determine the number of rows, unit numbers, and
purposes for instrument types attached to them. Whenever you add a light with an attribute list to your show a
separate worksheet row is automatically added for each attribute, with a decimal unit number suffix
corresponding to the attribute.
Example:

You have used a “Cyberlight Mode 1” attributes list for your “Cyberlight” entry in list
maintenance. If you then add unit #3 to your show and make its instrument type “Cyberlight”,
Lightwright will add unit #3 but it will also add 20 additional worksheet rows numbered 3.1
through 3.20, one for each attribute in the list.

Lightwright comes with a large set of attribute lists for many of the popular moving lights available. You can
either use one of these lists or create one from scratch.
To use an existing list, go to Maintenance/Instrument Type and then click on the “Att List Add” button and
choose your desired attribute list from the subsequent files dialog. You can then rename the instrument type if
you want to by clicking on the instrument type, typing the new name into the Maintenance window’s edit field,
and then clicking the “Update” button.
To create a new attribute list, go to Maintenance/Instrument Type and add a new instrument type. Then go to
the Attributes tab and click in the Attributes List column. A window will open where you can enter attribute
numbers and their purposes, or select an existing attribute list to use as the basis for your new list.
Enter an attribute number between 1-255 in each Attrib# field you want to use, and enter a purpose for that
attribute in the Purpose field. Attribute numbers do not need to be consecutive.
In Windows, double-click on any of the purpose fields to bring up the standard Choose List for purposes. On
the Macintosh, click the “List…” button to bring up the standard Choose List.
Once you set up attributes, you can save them as a reusable list by clicking on “Save List As…”, or you can
retrieve a previously saved set of attributes by clicking the “Use List” button.
If you change the quantity of attributes or their purposes, all lights using that attribute list will have their
purposes changed, and worksheet rows will be added and deleted appropriately.
If you want one or more attributes to hide when you click the collapse arrow in the worksheet, check the “Hide”
option for the appropriate attributes.
If you want attributes normally included when you print your paperwork, check the “Print” option for those
attributes. When it comes time to print, you can also choose to show All or None of the attributes (in all
instrument types).
Attribute lists can be freely shared between the Windows and Macintosh versions of Lightwright 4 without any
kind of file or format conversion.

Editing Features for Lights Attached to Attribute Lists
If you edit either the position name or unit number of any light attached to an attribute list, all of the other
related worksheet rows will also change their purpose or unit number.
Purposes of lights that are derived from attribute lists are controlled by the list, and the worksheet will show a
small black dot in the lower right corner of those cells, indicating that they cannot be edited. The first row of
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each light can have its purpose edited on the worksheet, but to change attribute purposes you will need to edit
the attribute list.
Editing the instrument type for lights on the worksheet is possible, but there are things you need to know:
If you want to change to another kind of light that is also attached to an attribute list, then be sure the new
instrument type has already been set up in Maintenance, including its attribute list. Then, when you change
the instrument type on the worksheet, Lightwright will add or remove worksheet rows as needed to
conform to the new type’s attributes.
If you change to a light that does not have an attribute list attached to it, then all of the existing attribute
rows will acquire the new instrument type and will be detached from their attributes. No worksheet rows
will be added or deleted.
If you change the instrument type from one that does not have an attribute list to one that does, then
Lightwright will add or remove worksheet rows as needed.
Whenever you drag any part of a light with attributes up or down the worksheet, all of the associated units will
automatically drag alone with it.
Attribute lists can be freely shared between the Windows and Macintosh versions of Lightwright 4 without any
kind of file or format conversion.
Edit/Attach to Attributes List
This option can create an attributes list based on existing worksheet rows, or it can simply attach existing
worksheet rows to an existing attributes list. Select the appropriate worksheet rows and then choose this
command.
Edit/Detach from Attributes List
Select one or more cells in more or more worksheet rows, choose this option. Any rows linked to an attributes
list will be disconnected from the list (and cannot be successfully reattached).

ACCESSORIES
In Lightwright 4, an Accessory is a “dumb” piece of hardware that can attach to a light. Any device that needs
power or control information is considered an instrument type, not an accessory.
“Dumb” Non-electrified accessories such as top hats and barndoors are no longer attached to lights using the
“accessories separator” phrase (such as: “6x9 w/top hat”). These accessories are now entered into a separate
“Accessories” column. Use Maintenance/Accessories to enter the kinds of accessories you want to use (up to a
maximum of 200).
To add accessories to lights on the worksheet, select the appropriate accessory cell(s) on the worksheet and
either choose Edit/Show List or double-click the cell. A form will open, where you can add and remove
accessories from the selected cell(s). You can also use the usual editing tools to work with accessory cells,
including using Append.
You CANNOT add accessories to the end of instrument types the way you could in LW3, which also means
you cannot use the “accessories separator” phrase as part of an instrument type name.
You can attach up to 10 different accessories to each light, and you can only use one of each kind of accessory
on a light.
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NOTE: Accessories needing any kind of control information (such as channel, power, or DMX) should be
entered on the worksheet as a separate row as an instrument type, not as an accessory.
Accessories can have their own stock quantities and weights, independent of the kinds of lights they are
attached to, as well as a short note.
The accessories separator can be any single character or combination of characters, but since it is no longer used
to separate instrument types from accessories, the default has been changed to "+" instead of "w/". The
accessories separator is used to display multiple accessories used in the same cell, and it is also used when
exporting in LW2 and LW3 format.

FOCUS CHARTS
Clicking on the Focus Charts tab adds focus chart fields to the regular worksheet. Note that only instrument
types with “Focus” checked in List Maintenance will have a focus status, and only focusable lights are included
in focus charts. (The default is focusable.). If you are unfamiliar with how to fill out and use focus charts, refer
to the Focus Charts section of the Lightwright 4 Reference Manual, which contains detailed instructions.
The Focus Status column is where you indicate the current focus status of each light:
Red circle with “F” in the middle if the light is not focused
Yellow diamond if partially focused
Green circle if the light is focused
Click on the focus status column to change the light’s status. Entering any data into any of the focus fields or
drawing anything on the Focus Sketch will automatically set the status to Partially focused. You can use both
Limits and the worksheet’s View menu to see what has and has not been focused.
Most editing and other commands work the same in focus charts as they do in the regular worksheet, but there
are some important differences, especially in Copying and Pasting:
Key(s)
Home
End
Up/Down
Copy
Clear
Cut
Copy
Paste

Ctrl+G
Cmd+G
Ctrl+Y
Cmd+Y
Left/Right
Ctl+Left/Rt

Worksheet
Moves to first column of worksheet
Moves to last column of worksheet
Moves up or down one row
Copies selected cell(s)
Applies to selected cell(s)
Applies to selected cell(s)
Applies to selected cell(s)
Applies to selected cell(s)

Focus Charts
Move to first field (L/R) of current unit
Moves to last field of current unit
Moves up or down one field
Copies entire focus, including graphics
Applies to entire focus form
Applies to entire focus form
Applies to entire focus form
Applies to entire focus form if unit being
pasted to is not the one the on the
clipboard was copied from
Opens Sketch window

Toggles Focus Status

Toggles Focus Status

Moves between columns
Moves between columns

Moves between fields
Sets Beam & Axis tick marks

Click on any focus field label to clear the adjacent data field (this method also works on Beam and Axis).
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There are Standard charts available which have a fixed layout (except for font & type size, which can be
changed), or you can assemble your own layout from the various parts that make up a focus chart. If you choose
to use the Standard chart, the overall size of the chart will depend on the type font and size you choose. If you
assemble your own chart using the various objects, you have complete control over the size of the chart.
Caution! Standard charts will grow and shrink depending on the data in them, and will use word wrap within the
areas of the chart. Custom charts do not use word wrap, which can result in messy printouts unless care is taken
when planning the layout.
In addition to using them on focus charts, you can also add focus chart objects to the Channel Hookup.
Unit numbers are always boldfaced on standard charts, as are the entries for the designer location.
In addition to the entry fields for focus location, shutter cuts, and other information, there is also a Focus Sketch
area. The Sketch can have a default background image (usually the ground plan), no background, or a specific
graphic as its background. Using simple drawing tools, you can then draw on top of the background to show
shutter cuts or make other notes.
Use Setup/Focus Charts to choose a .jpg, .gif, or .bmp file to use as the default background. This is also where
you can choose the cut field labels and a graphic for the Focus Charts Cover Page.
A copy of any graphics you use in the focus charts or in your layout will be placed into your show file’s
Graphics folder. There are reports and error checks available that can tell you where each graphic is being used
or if there are any unused or missing graphics. No matter how many times you use a particular graphic in a
show, only one copy of the graphic file will be placed in the Graphics folder.
Graphics can be in .jpg, .gif, or .bmp format. If you are working exclusively on the Macintosh, you can also use
PICT graphics, but the Windows version of Lightwright will not be able to read them. Be sure that the aspect
ratio of your focus sketch graphics is 1:1.5. For example, if your graphic is 300 pixels high, it should be 450
pixels wide, otherwise the image will be distorted when Lightwright fits it into the sketch area.
To work on the sketch, click anywhere in it and a window will open with an enlarged version of the sketch, with
a palette consisting of a row of tools, a row of colors, and a group of line weight samples:

The tools available are Line, Dashed Line, Rectangle, Circle, Freehand, and Text. If one or more objects have
already been drawn on the sketch, then Selection and Eraser tools will also appear.
To draw, click on a tool, color, and line weight, then use the mouse to draw.
The freehand tool cannot draw infinitely long lines; if it stops short before you are finished, simply
start another freehand segment.
To use the text tool, type the text you want into the Text field, choose a font and size (8, 10, 12, and 14
are the available text sizes), and then click on the sketch where you want the left end of the text to be
located. The left edge of the text will always be where you click, but the rest of the text may vary in
size depending on the size of the graphic when it is printed, because Lightwright will try to keep text
readable, and in doing so the text may be relatively larger than the other drawn objects when the chart
is very small.
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To move objects already drawn, click the Selection tool and use it to drag objects as needed.
To erase one or more objects, click the Eraser tool and then click on each object you want to delete.
To choose a background other than the default, use the Default pop-up menu. Like the default
background, the graphic can be any .bmp, .jpg, or .gif file.
The focus sketch will be scaled on the worksheet and on printouts to fit the available space.

Focus Chart Cover Page
To create a cover page for your focus charts, first design a nearly full-page-sized graphic using your favorite
graphics editor such as Photoshop. The cover page graphic normally includes a floor plan showing where the
zero-zero reference point is as well as common abbreviations used in the charts (such as “OOH” for “Out Of
House”).
Next, switch to Layout and choose Focus Cover Page from the Paperwork menu. After that, use Layout/Focus
Charts Cover to add the cover page graphic to the page, then drag the graphic into the desired location within
the page.

WORK NOTES
Lightwright can record and track the progress of work notes. Each work note has a Status and can have one or
more Categories.
The Status can be:
To Do

The note is a task that has not yet been done.

Pending

The note is something you will probably want to do, but “not quite yet”. Perhaps
you want to think some more before actually asking someone to get out their
wrench.

Discuss

Something that you need to talk about before you can decide what needs to
happen.

Done

The note has been dealt with.

Categories:
Any work note can be assigned to none, one, or any number of the ten possible work note categories.
Likely choices include things like “Work”, “Focus”, “Cleanup”. Use Setup/Work Notes to change the
names of the categories.

Adding Work Notes
To add a new work note, either click on the New button in the Work Note window, use Utilities/Add Work
Note while working in the Worksheet, or click a blank Work Status column on the worksheet. Any of these
methods will open the Work Note form, where you can add a new work note
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Work notes can be attached to a specific light, associated with a particular bit of information in a column, or just
some useful text not linked to anything in particular.
Attached to Specific Lights
To add a work note that refers to one or more specific lights:
Select any part of the light in the worksheet by clicking on it. Open the Work Note form. Enter the
appropriate text for the note, choose a category and status for it, and choose Attach Note to Selected
Light(s) from the pop-up menu.
Attached to Specific Information
To add a work note that applies to a specific bit of information in a column (such as changing R-33 to L-161):
Open the New Work Note form. Type the appropriate text for the note into the text field at the top of
the form, choose a category and status, then choose the appropriate column from the Attach Note To
popup menu.
In the text field under that menu, type text that matches the data the note applies to. In the above
example, you would type “R-33” (without the quotes).
Once you do this, any light that has text matching your entry in the category you’ve chosen will be
flagged on the worksheet with the appropriate work note status symbol.

Viewing & Editing Work Notes
Open the Work Notes window by choosing “Show Work Notes” from the Edit menu (Ctrl/Cmd K), or by
clicking any work note icon on the worksheet.
To view work notes, select one or more of the Status check boxes in the upper left-hand corner of the window.
To narrow down the list, you can turn on or off any of the ten categories. For example, if you want to see Focus
notes that need to be done, click the “To Do” checkbox and the “Focus” checkbox.
Use the All button to turn on and off all of the category checkboxes without taking the time to go to each of
them individually.
To change the status of a note, click on the note’s status icon at the far left of the window. A popup menu will
appear listing the four choices.
To change the categories for a note, click in the appropriate column(s) to the right of the note. You can use
categories as a kind of ripple sheet by clicking all of the relevant categories at first and then un-checking them
as each relevant category has been dealt with. When the last category has been cleared, mark the note as Done.
To edit a work note, select it in the Work Notes window and then click the Edit button. If work notes are
displayed in the worksheet, you can click on the work note there to edit it.
To change the order of work notes, hold down the mouse pointer in the blank space to the far left of the note. A
drag rectangle will appear. Drag the note up or down the list and release it at the appropriate point in the list.
Work notes will always be sorted first by status and then by the order you drag them into.
To delete a work note, click on the note and the click the Delete button. Deletions are immediate and do not
require confirmation, so think carefully…
To delete all work notes marked as “Done”, click the Purge button.
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If you want to have a permanent log of all of your work notes, you can choose to have work notes added to a
WorkLog.txt file whenever you choose Purge. To turn on this feature, choose Work Notes from the Setup
menu.
The WorkLog.txt file is in tab-separated format so that it can be brought into any spreadsheet. The log contains
five columns, with one row per work note:
Date Entered:

The date the work note was added to the show file. The date is in YYYYMMDD
format so that it can be sorted by spreadsheets as a number.

Date done:

The date the work note was done. This date is also in YYYYMMDD format.

Note:

The text of the work note

Categories:

The names of any of the categories the work note had checked.

Applies to:

What the note applied to. If the note applied to more than one specific light, only the
first one is included here.

FILE SHARING, MERGING, COMPARING
Sharing Work Notes
You can share work notes with other people:
Either
Use File/Export Work Notes and then use File/Merge Work Notes
With this method, you can export your work notes into a file separate from your
regular show file and give it to another person, who uses File/Merge Work Notes to
bring the work notes into their copy of the Lightwright show file.
or
Use File/Merge Work Notes
This method takes work notes from one Lightwright show file and merges them
directly into another show file.
As the name implies, these methods merge work notes with those already in a show file. It does not replace
them, but if there are two identical notes, the merge is smart enough not to make duplicates.

Sharing Changes & Focus Charts
The Merge menu now includes merging Work Notes, Worksheet Changes, and Show Files as well as Data.
To copy changed worksheet cells from one show file to another:
Use File/Merge Worksheet Changes
To copy focus charts from one show file to another:
Use File/Merge Show Files, check the “Focus Charts” option
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CAD Import & Export
Several new options here:
“All imported data is On Light Plot” will automatically set the “On Light Plot” flag in List Maintenance for
each instrument type you import. Exporting can also use the “On Light Plot” flag to control which worksheet
rows get exported.
“Export only the first row of lights with attributes” screens out attribute rows, so that only the first row of a light
with multiple attribute rows is exported. (Lights without attributes aren't affected. Without this option, exporting
a moving light with multiple attributes will produce a data record for every attribute. If you're exporting to a
CAD program, this is probably not a desirable thing, hence the new option.
Lightwright has a Symbol data field, but just like the External ID field, you cannot edit it from within
Lightwright. You can view it (along with the External ID field) by choosing External ID + Symbol when you
set up worksheet columns by right-clicking on the worksheet.
When you import data into the symbol data field, if there is no default symbol name for that instrument type,
then the symbol name being imported will become the default for that instrument type.
If the instrument type does not have a default wattage in the Maintenance window, then Lightwright will set a
default based on the first instance of that instrument type that is imported that has a wattage.
Furthermore, if you change the instrument type for a worksheet row while in Lightwright, it will assign a new
symbol to the worksheet row based on the default symbol for the new instrument type.
Some things to remember about lights with attributes and importing and merging:
If you go to Maintenance/Instrument Type and change the number of attributes on a light, Lightwright
will create or remove worksheet rows as needed to match the attributes list.
If you Import or Merge a data record into Lightwright without including the attribute rows and an
attribute list already exists for that instrument type, then Lightwright will create worksheet rows as
needed to fill out the light according to the attributes list.
In both cases, Lightwright will not renumber or create channel, dimmer, or circuit numbers when it adds or
removes worksheet rows.

LAYOUTS
Layouts saved by version 4 can now be shared freely between the Windows and Macintosh versions of
Lightwright without any kind of conversion. If you open a version 2 or version 3 layout and then save it, it will
be saved in version 4 format.
Layouts can be saved in the show’s “Layouts” folder, and pop-up Layout menus will show layouts in both the
Lightwright application’s Layouts folder as well as any layouts found in the current show’s Layouts folder.
Layouts above the dividing line in the menu are in the show’s folder, ones below the line are in Lightwright’s
folder.

Menus
A new Layout menu consolidates many options that were previously spread out among other menus, including
Paperwork/Margins, Paperwork/Options, Edit/Clone, and the entire contents of the Header, Body, and Ganging
menus.
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To add or remove data columns from a layout, choose “Body Columns…: from the Layout menu. A window
will open where you can turn columns on and off. You can also drag column headers to Lightwright’s trash can
to remove items, and this is still the only way to remove vertical lines from paperwork.
The Macintosh’s Font & Size menus are gone, replaced by contextual menu clicks and Layout’s Attributes
menu.
A new Temporary Settings item in the Layout menu lets you choose options such as printing in color, omitting
attributes, and watermark temporarily so that you can see them while working on the page layout.

First Page and Next Page Buttons
These buttons will take you through, page by page, through entire printouts, giving you a pretty good idea of
what your paperwork will look like when printed. Note that these buttons are not available for all kinds of
paperwork.

Paperwork Titles
In Lightwright 3, paperwork names were saved in both the show file and in the layout. Whichever was opened
last, won. This confused lots of people, especially if they had customized column titles and paperwork names
for a specific show, because when they opened one of their layouts created while they were using a different
show file, the paperwork title changed to something they didn't want.
Therefore, beginning with version 4.0.7, both show files and layouts have their own separate versions of the
paperwork names. Use Layout/Options to tell Lightwright whether the layout's paperwork name is to override
whatever name the show file has for that kind of paperwork.

Page Headers & Objects
Changes made to any part of the page header now automatically apply to all of the various kinds of paperwork,
not just the one being worked on.
Page Header graphics are kept in the Layouts folder. Like all graphics, a copy of the file you choose will be
made and placed in the Layouts folder.
The show’s filename has been added to the Layout menu as an object you can include on page headers.
The “Miscellaneous Text Block” is gone. If you have been using it, create a graphic (using a graphics
application) and use the graphic object instead. (Or use the new “Standard Focus Chart” or “Focus Chart
Objects”.)
Macintosh only: To add a graphic in Lightwright 3, you put it on the clipboard and then selected
Header/Graphic or Body/Graphic. In version 4, you will need to choose a graphic file instead of using the
clipboard.

Focus Charts
When designing a layout for focus charts, you can either choose a standard pre-defined focus chart layout that
matches the one in Lightwright’s Focus worksheet tab, or you can design your own. Choose Focus Chart
Objects from the Layout menu to choose which kind of charts you want to use and which objects you want on
the focus chart.
There are Standard charts available which have a fixed layout (except for font & type size, which can be
changed), or you can assemble your own layout from the various parts that make up a focus chart. If you choose

Page 21 of 30

to use the Standard chart, the overall size of the chart will depend on the type font and size you choose. If you
assemble your own chart using the various objects, you have complete control over the size of the chart.
Caution! Standard charts will grow and shrink depending on the data in them, and will use word wrap within the
areas of the chart. Custom charts do not use word wrap, which can result in messy printouts unless care is taken
when planning the layout.
In addition to using them on focus charts, you can also add focus chart objects to the Channel Hookup.
Unit numbers are always boldfaced on standard charts, as are the entries for the designer location.
If you design your own focus chart layout, there are new Attributes menu options that will be useful:
Align Tops,
Align Bottoms,
Align Lefts,
Align Rights,
Distribute Horizontally,
Distribute Vertically
These commands will align or distribute selected elements, including header items and focus chart objects.
Shift-click to select more than one or more objects, then choose the appropriate menu option. You can also
choose these commands from the contextual menu available by right-clicking.
Note that focus charts are drawn only for lights flagged in List Maintenance as having a focus chart.
To create a cover page for your focus charts, first design a nearly full-page-sized graphic using your favorite
graphics editor such as Photoshop. The cover page graphic normally includes a floor plan showing where the
zero-zero reference point is as well as common abbreviations used in the charts (such as “OOH” for “Out Of
House”).
Next, switch to Layout and choose Focus Cover Page Graphic from the Layout menu. Finally, use
Paperwork/Focus Charts Cover to drag the graphic into the desired location on the page.
The “Print dimmer table” option in Layout Options is no longer available (it hadn’t actually done anything since
before version 2).

Flags and Colors
Worksheet flags can now be one of the columns in a Layout, and if you choose Paperwork/Options/Flags extend
across page, then the color will be carried all the way across the printed page, behind the entire row that it
applies to.
In the Worksheet Flags & Colors window, a new slider control lets you determine the intensity of the color used
when printing colors when they are extended across the page.
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PRINTING
Attributes
When you print paperwork, you can choose to include or omit attributes. If you choose to omit them, only
attributes with their “Hide” option un-checked will appear on the printouts. Lightwright will print a warning
under the page header warning you that attributes are not shown, but it is important to remember these points:
Printing a Channel Hookup without attributes and without the “Print unused” option selected will produce a
listing that may be misleading if you use it to look for spare channels.
Printing a Channel Hookup without attributes but with the “Print unused” option selected will produce a
hookup that skips numbers where attributes would be, but prints a line for each unused channel, just as it
did in Lightwright 3.
The same things apply to other kinds of paperwork such as Dimmer Hookups.

Work Notes
Printing work notes is a new kind of paperwork available under File/Print.
When printing work notes, you can choose to print work notes in any of the ten categories and with any of the
four work note status levels. You can also sort the notes by Priority (their order in the work notes list), Position,
Channel, or any of the other usual sorting categories.

New Options & Buttons
Clear All
Make Default

Clears all current choices for what you want to print
Makes the current print choices the default setting. Default settings do not
include the layout, watermark, limit, or which items are selected for partial
printouts.

Highlight Changes

Like the worksheet, changes are printed in red

Print Only Items With Changes

Only worksheet rows with changes somewhere in them will be printed

Collapse All Rows

Any collapsible worksheet rows will NOT be printed if this option is
selected. Otherwise, all rows will be expanded and printed.

Print Attached Work Notes

Any work notes attached to specific lights, positions, channels, dimmers,
etc. will be printed adjacent to the appropriate item.

Print In Color

If this option is NOT checked, then change highlights will be done by
underlining or outlining the relevant text.

Watermarks
You can use any .jpg, .bmp, or .gif graphic to serve as a watermark behind all printed text. Put the graphic into
the “Watermarks” folder inside the Lightwright folder, and it will appear on a Watermarks pop-up menu. The
graphic can bee any size or resolution, but Lightwright will NOT resize it when printing, so be sure that the
watermark isn’t larger than the printer’s page size. There can be up to 40 watermarks in the Watermarks folder.
A selection of suitable watermarks is included in Lightwright’s Watermarks folder as part of the Lightwright
package. You may modify or remove them as you like.
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COUNTING
Keyboard shortcuts have been added, and some new color counting options are available:
Count as Color

“Count as Color Cuts” looks at cells and breaks them down into
individual colors using both the “list separator” and “combining in a
single frame” entries. This option presents the results as color frames. It
option is available for user-definable text columns 1 through 6. If you
choose this option the text in the column will be broken up by color
separators, and totals will be shown using color frame sizes. Counting
sheets of color is not available for these columns.

Count as Framed Color

This method looks at cells and breaks them down into individual
colors using only the “list separator” entry. This option presents the
results as color frames.

Count broken down by list separator

This option will break down any entries in the chosen column using
your list separator character. Particularly useful if you use one of the
user-definable text columns for things like cable & twofer lists.

DIMMERS & CONTROL
Dimmer ranges can now have more than capacity of dimmer within them (the Dimming System edit field will
say “Mixed” if there is more than one capacity within the current range.) Use View Details to set a specific size
for each dimmer. Note that if you have mixed ranges, you cannot use Automatic Dimmer Assigning to assign
dimmers within existing ranges.

Dimmer Details
Dimmer ranges identified as “Peripheral” will not appear in the Dimmer Details window, as there is nothing
relevant there.
A new “Capacity” column is available here; use it to enter capacities for individual dimmers if they are different
from others in the same rack. You can also use single-click pasting to assign wattages to dimmers, just like you
can in the worksheet (Windows: hold down Ctrl+Shift keys, Mac hold down Option key).

Automatic Dimmer Assigning
Assigning Fluorescent dimmers now automatically uses two dimmer slots for each dimmer needed, as most
fluorescent dimmers occupy two slots in the dimmer rack.
If dimmers in any rack are of more than one capacity, then the option to Assign Within Existing Arranges will
not be available. All of the dimmers within a rack must be the same capacity in order to use Automatic Dimmer
Assigning.

TEMPLATE / GOBO SIZES
New to the Setup menu is Template/Gobo Sizes. This window lets you assign template holder sizes to each of
your instrument types.
To add a new template size, type its name into the edit field at the bottom of the form and then click “Add New
Size”. The name will be added to the list on the left side of the window. If you want to change a name, click on
it on the list, edit the text in the edit field, then click “Update”.
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To change the order of entries in the size list, drag them up and down.
To assign a template size to an instrument type, click on the template size and then click on the appropriate
instrument type. You can click on as many instrument types as you like without re-selecting the template size.
To remove a template size from an instrument, click on “(None)” in the size list and then click on the
instrument type.
There is a limit of 100 different template sizes.

REPORTS & ERROR CHECKS
New Tech Reports
Circuit Names in each position
Power loads in each position (in amps and watts)
Total weight of each position (includes total weight overall)
Graphics List, alphabetical
Shows filenames for all graphics, with the position name(s) where each is used
Graphics List, by position
Lists each position & the filenames of graphics files used there

New Error Checks
Dimmers without phases
More than one phase per position
Unused graphic files
Missing graphics
Missing:
Focus Chart entries
Control Info (ckt capacity, voltage, etc.)
Number5
Number6
Accessory
Text5
Text6
Gobo Sizes
CAD Symbol
CAD Legend

PREFERENCES
Lightwright Prefs have moved to a new location in accordance with the latest operating system standards.
In Microsoft Windows, Lightwright preferences will be found at the bottom of the Edit Menu. In OSX, they are
under the Lightwright menu.
Show Prefs are now “up front” in the Setup Menu instead of being in a sub-menu.

New Lightwright Preferences
The “Dangerous” category of preference has been eliminated. Some of those options have been retained, while
others have been eliminated. “Never tell me when vocabulary changes” is gone. Instead, Lightwright will never
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tell you when column titles change, but it will always tell you when vocabulary (“No Color”, template phrase,
color separator, etc.) changes, and when it does it will tell you exactly what changed and what the new phrase
is.
General
Never tell me when column titles change

If the column titles in a file being opened are different from
those in the previously open file, this option will instruct
Lightwright to keep quiet about the differences.

Save As… creates a new show file folder

This instructs Lightwright to automatically create a new folder
with the same name as the show file whenever you choose the
Save As option, and it will also create the show file within that
new folder. However, if you choose an existing show file to
overwrite, Lightwright will not create a new folder.

Each version 4 show file should be put into its own separate folder. Within that folder, Lightwright will
automatically create “Graphics” and “Layouts” folders containing copies of any of the graphics (focus charts,
page headers, etc.) or layouts used by the show.
When Lightwright creates a new show folder, it will take the name of the show file and add a suffix to it to
make the folder name. The default suffix is “-LW”.
Example:

The folder suffix is “-LW” and you use Save As… to save a show file with the name
“King Lear.lw4”
Lightwright will create a folder named “King Lear-LW” and within that folder a
show file with the name “King Lear.lw4”

If you do not want Lightwright to create folders for you, turn off this option. Doing so will mean you must
create folders manually.
Dimmer Phase Labels

They can now be changed from A,B,C to R,Y,B, or whatever
your local designations are.

Enable mouse scroll wheel

If your mouse has a scroll wheel, turn on this option to use your
mouse wheel. The Macintosh version automatically supports
mouse wheels, so this option is not needed.

Worksheet
Ignore Text Case

When this option is checked, if what you enter matches an entry
already on the appropriate list (ignoring uppercase and
lowercase), then what you enter will be changed to the same
case as the entry already on the list.

Worksheet Row Background Color

Lightwright can put “color bars” behind worksheet rows to make
for easier viewing. Three colors and white are available. You can
also use the Color Picker to choose your own color.

File Sharing
Your Initials

To help Lightwright keep track of who makes changes when and
in what copy of the show file, you need to enter your initials
here. Initials must be 1-2 uppercase characters and must be
different from anyone else using the same show file.
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File Permissions

OSX uses file permissions to control access to files. The defaults
for all files created by Lightwright are:
Owner: Read/Write
Group: Read Only
Others: Read Only
If you are working on a network and you want to allow other
users to share your files, check the “Group and Others have read
& write permission for all files” option. This will change the
permissions for everyone to Read/Write.
This option is only available under Macintosh OSX.

New Show Preferences
Show Preferences are no longer under a “Prefs” menu and are now found under the Setup menu.
Vocabulary
“Separate colors (and templates) to count them individually” has been changed to “Separate lists to count items
individually” because user-definable text columns can now be broken down into components.
Numbers
Each of the six user-definable number columns can be formatted as any one of these data types:
Channel
Dimmer
Wattage
##### (+-0-32000)
#####.# (+-0-32000.9)
#####.## (+-0-32000.99)
IP Address (###.###.###.###)
F-Keys
Because bookmarks now occupy function keys 1-4, use of the function keys for playback is limited to function
keys 5-12.
Focus Charts
Default Background Graphic:

Choose any appropriate graphic in .jpg, .gif, or .bmp format. A
copy of any graphics you use in the focus charts or in your
layout will be placed into your show file’s Graphics folder. If
you are working exclusively on the Macintosh, you can also
use PICT graphics, but the Windows version of Lightwright
will not be able to read them.

Be sure that the aspect ratio of your focus sketch graphics is 1:1.5. For example, if your graphic is 300
pixels high, it should be 450 pixels wide, otherwise the image will be distorted when Lightwright fits it
into the sketch area.
Focus Cut Field Labels:

Each of the six focus cut data fields can have whatever label
you prefer. The permanent labels are only suggestions and
may not be useful in every show.
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Focus Charts Cover Page Graphic

Use this option to choose the graphic you have created for
your focus charts cover page.

The Focus Charts Cover Page Graphic is usually a nearly full-page-sized graphic that includes a floor
plan showing where the zero-zero reference point is as well as common abbreviations used in the
charts (such as “OOH” for “Out Of House”).
Work Notes
Add purged work notes to the WorkLog.txt file You can choose to have work notes added to a WorkLog.txt
file whenever you purge “Done” work notes.
The WorkLog.txt file is in tab-separated format so that it can be brought into any spreadsheet. The log
contains five columns, with one row per work note:
Date Entered:

The date the work note was added to the show file. The date is in YYYYMMDD
format so that it can be sorted by spreadsheets as a number.

Date done:

The date the work note was done. This date is also in YYYYMMDD format.

Note:

The text of the work note

Categories:

The names of any of the categories the work note had checked.

Applies to:

What the note applied to. If the note applied to more than one specific light, only the
first one is included here.

Work Note category names

Enter both short and long versions of your work note
categories here.

MISCELLANY
Help
Help is no longer available by pressing F1. Instead, use the Help menu. F1 is now used as a shortcut to go to
Bookmark #1.

Edit/Search & Replace:
You can now replace text within phrases used on the worksheet.

Worksheet Columns
A new “Use for ALL” button has been added to the Worksheet Columns dialog. This button makes the on/off
status of all columns match the current one, except for the primary sort category, which will remain unchanged
(usually visible).

Student License
The student license of Lightwright uses the same software and has exactly the same set of features and
capacities as the Individual and Institutional licenses. However, it does have restrictions:
Licensed only to bona fide students with valid student ID
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Licensed for a three year period maximum, after which time it will cease to function
The word “STUDENT:” is printed in front of the student’s name on all paperwork
Not upgradeable to Lightwright 5 or later (it would be cheaper to buy another student license)
The student version can be upgraded to a regular Individual license at any time by paying the price difference
between the two versions. If a student wishes to upgrade to Lightwright 5 or beyond, they first must upgrade to
the individual version.

What Makes A Light?
With all the new options for unit numbers, you probably want to know how Lightwright decides when two
worksheet rows are multiple parts of the same light:
Rows with unit# 0 are always different lights
Rows with different position names are always different lights
If the position names are the same, then:
If the unit numbers in both rows are the same, then they are parts of the same light.
If the two rows use letters differently, then they are different lights.
Examples:

Unit numbers 4 and 4.0 are the same light
Unit numbers 4.0 and 4.1 are the same light
Unit numbers 4 and 4a are different lights
Unit numbers A1 and 4.1 are different lights

If the unit numbers use decimals and the whole number parts match, then they are considered a single
light.
Example:
Unit numbers 4.0, 4.1, and 4.25 are all parts of the same light
Unit numbers 4.5 and 5.1 are two separate lights
If the unit numbers use prefix letters (such as A1, B2, M1, or ML4), then
If the two instrument types are either moving lights or devices, then
If the unit numbers are different in any way, then they are separate lights:
Example:

Unit numbers M1 and M2 are separate lights

Otherwise, they are considered striplights, which means only their letters have to match:
Example:

Unit numbers M1 and M2 are two circuits in a single striplight
Unit numbers A1 and B1 are two separate striplights

Options Removed
In Exporting, the option to “change 1A to 1.1” has been removed now that 1.1 is a legal Lightwright number
Always save preferences without asking. Preferences are always automatically saved.
Show title font & size override. Now that show-specific layouts are readily available under the pop-up Layout
menu, this option is no longer needed.
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KEYBOARD SHORTCUTS
Here is a summary of what all of the various keys do, with notes as to where they are different in the Worksheet
vs. Focus Charts
Key(s)
Home
End
Up/Down
Ctl+Home
Ctl+End
Ctrl+Up
Ctrl+Down
F1-F4
Ctl+F1-F4
Cmd+F1-F4
F5-F12
Ctl+F5-F8
Cmd+5-8
Copy
Clear
Cut
Copy
Paste
Ctrl+G
Cmd+G
Ctrl+Y
Cmd+Y
Left/Right
Ctl+Left/Right
Ctl+K
Cmd+K
Ctl+F9
Cmd+9
Ctrl+U
Cmd+U
Tab
Shift+Tab
Esc

Worksheet
Moves to first column of worksheet
Moves to last column of worksheet
Moves up or down one row
Moves to first column & row of
worksheet
Moves to last column & row of
worksheet
Moves up one row
Moves down one row
Go to Bookmarks 1-4
Set Bookmarks 1-4

Focus Charts
Move to first field (L/R) of current unit
Moves to last field of current unit
Moves up or down one field

Playback text
Count
Types/Accessores/Color/Templates
Copies selected cell(s)
Applies to selected cell(s)
Applies to selected cell(s)
Applies to selected cell(s)
Applies to selected cell(s)

Playback text
Count Types/Accessores/Color/Templates

Toggles Focus Status

Toggles Focus Status

Moves between columns
Moves between columns
Show Work Note window

Moves between fields
Sets Beam & Axis tick marks
Show Work Note window

Add Work Note

Add Work Note

Toggles Universe format on/off

Toggles Universe format on/off

Moves selection one column right
Moves selection one column left
Same as “Go Back” button

Moves selection one column right
Moves selection one column left
Same as “Go Back” button

Moves to the previous light
Moves to the next light
Go to Bookmarks 1-4
Set Bookmarks 1-4

Copies entire focus, including graphics
Applies to entire focus form
Applies to entire focus form
Applies to entire focus form
Applies to entire focus form if unit being
pasted to is not the one the on the clipboard
was copied from
Opens Sketch window
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